How to: SOA Suite 11g R1 on Oracle Linux in VM Ware Fusion

Introduction
When i started reading the books ʻGetting Started with ORACLE SOA Suite 11g R1ʼ (by
Heidi Buelow et al.) and ʻSOA Suite 11G Handbookʼ (by Lucas Jellema) i needed a running
SOA Suite 11g environment to be able to do the exercises. As a Mac user i use VM Ware
to virtualize my educational environments, preferably on a Linux operating system to
minimize the cost of licenses and reduce the overhead of the guest operating system on
my host operating system. Both books do contain installation guidelines, but are focussed
on installation of the SOA Suite 11g on a Microsoft Windows operating system. Although
the getting started handbook does give you some hints how to tune the environment, the
performance, on a system with the suggested 3Gb RAM, is to low to consider it workable.
This document describes step-by-step how to get an up and running SOA Suite 11g R1
environment with a minimal environment. The definition of a minimal environment is
relative. The installation is resource intensive, so the phrase ʻless is moreʼ is not applicable
here. I got this VM running on a Macbook Pro with a 2.6 Ghz Core 2 Duo processor, 6GB
RAM and a Hitachi 7200rpm hard disk. Although this document describes how to install
Oracle SOA Suite on Oracle Enterprise Linux in a VM Ware Fusion virtual machine. It
generally can be used on any virtual or bare-metal system running any supported Linux
variant.
When completing the installation process, the environment will reassemble the schema
below.
Mac OS X
VM Ware Fusion
OEL R5u6 64bit
JDeveloper 11g

WebLogic Server 11g

JDeveloper 11g

AdminServer
soa_server1
bam_server1
osb_server1
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Preparation
Download the necessary software from the following Oracle websites;
https://edelivery.oracle.com/linux
Part
Number

Name

V24479-01

Oracle Linux Release 5 Update 6 for x86_64 (64 Bit)

https://edelivery.oracle.com/
Part
Number

Name

V24338-01

Oracle WebLogic Server 11gR1 (10.3.4) Generic and Coherence

V24311-01

Oracle Fusion Middleware Repository Creation Utility 11g
(11.1.1.4.0) for Linux x86

V24313-01

Oracle SOA Suite 11g Patch Set 3 (11.1.1.4.0)

V24372-01

Oracle JDeveloper 11g and Oracle Application Development
Framework 11g (11.1.1.4.0)

V24330-01

Oracle Complex Event Processing 11g (11.1.1.4.0) for Linux x86-64

V24316-01

Oracle Service Bus 11g (11.1.1.4.0)

V17530-01

Oracle Database 11g Release 2 (11.2.0.1.0) for Linux x86-64

V17532-01

Oracle Database 11g Release 2 Client (11.2.0.1.0) for Linux x86-64

http://www.oracle.com/technetwork/java/javase/downloads/index.html

#

Part
Number

Name

Java SE 6
Update 21+

Download the Java SE 1.6.0 with build 21 or higher for Linux x64
from Oracle Technology Network. If you have the choice select the
jdk-6u??-linux-x64-rpm.bin instead of the jdk-6u??-linux-x64.bin
file.

#
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Expand the zip files in a folder labeled "Soa_Suite_Components", make sure you unzip
both parts of Oracle Database 11gR2 in the same folder. I chose to unzip each product to
a sub-directory labeled with the partnumber, resulting in a directory-structure similar to the
example below. The paths used in following instructions will be based on this directory
structure.
.
|-|
|-|
|-|
|-|
|
|
/
.
/
|
|
|
|-|
|
|
|
|
|-|
|
|-|
|-|
|-|
|
|
|
|
`--

JDK
`-- jdk-6u23-linux-x64-rpm.bin
V17530-01
`-- database
V17532-01
`-- client
V24311-01
|-- BC4J
|-- assistants
|-- bin
/
.
/
|-- relnotes
|-- util
`-- xdk
V24313-01
|-- Disk1
|-- Disk2
|-- Disk3
|-- Disk4
`-- Disk5
V24316-01
|-- Disk1
`-- Disk2
V24330-01
`-- ofm_ocep_linux_11.1.1.4.0_64_disk1_1of1.bin
V24338-01
`-- wls1034_generic.jar
V24372-01
|-- extras
|-- install_guide
|-- jdev_extensions
|-- jdevstudio11114install.jar
`-- middleware_extensions
V24479-01
`-- Enterprise-R5-U6-Server-x86_64-dvd.iso
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Create a Virtual Machine
Create in Fusion a new Virtual Machine using the Virtual Machine Assistant. Use the
following information as a guideline through the assistant steps.
Introduction# #
Installation Media#
Operating System#
Finish# #
#

Continue without disc
Create a custom virtual machine
Linux, Oracle Enterprise Linux 64-bit
Finish

Use the following information as a guideline finalizing your VMs configuration. You can
change the configuration by selecting Virtual Machine->Settings... in the fusion menu-bar.
Sharing# #
#
#
#
#
#
#
#
#
#
Processor & RAM#
Advanced#
#
#
#
#
#
Printers# #
#
Network# #
#
Hard Disk#
#
#
#
#
#
#
#
#
#
Sound# #
#
USB Devices# #
Other Devices##

Enable the option 'Share folders on your Mac' and add the previously
created folder "Soa_Suite_Components" with "Read&Write"
permissions.
Select "1 processor core" and at least 4096MB RAM
Preferred virtualization Intel VT-x or Intel VT-x with EPT if supported
by your processor (Xeon, i5, i7). Hard disk buffering dis-abled
Disabled
NAT
Replace the current harddisk definition by a SCSI harddisk of 50GB.
Select the option "Pre-allocate disk space" and disable the option
"Split into 2GB files".
Disabled
Disable "Enable USB 2.0 Support" and remove the USB Controller
Remove the Serial Port

By default the CD/DVD drive follows the HDD in the VMs BIOS boot order of devices.
Therefore when it is required to boot from CD/DVD with a VM which already has been
installed with an operating-system, the VM will boot from the HDD instead of the CD/DVD.
You can change the boot order of devices in the BIOS. The challenge only is to get in the
BIOS setup which requires that you press function key 12 within a second or two after
powering up the VM. There is a less frustrating to open the BIOS setup.
Make sure that the VM has been shutdown. Open in Fusion the Virtual Machine Library
window, menu-bar->Window->Virtual Machine Library. Select the VM, ctrl-click and select
Show in Finder. A new finder window is opened and the Virtual Machine package is
selected. Control-click on the VM Package and select Show Package Contents. A new
finder window is opened again showing the contents of the package. Find the file with the
extension .vmx. When you named your VM SOA_SUITE_11G_OL_R5_64BIT, the name of
the file will be SOA_SUITE_11G_OL_R5_64BIT.vmx. Open this file with an text editor, e.g.
fraise and add the line shown below anywhere in the file and save the file.
bios.forceSetupOnce = "TRUE"
Boot the VM and the BIOS setup page will be opened once. If VMware fusion reports a
Dictionary problem, when booting the VM, the previously added line to the vmx-file was
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probably already present. Then remove one of the two similar configuration options and
make sure the remaining option has the value “TRUE”. When the BIOS setup page is
opened, change the boot order of the drive. Use the following screenshot as a guide.
When done exit the bios with saving the changes.
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Oracle Enterprise Unix installation
Configure the VMs CD/DVD device to use the Oracle Linux ISO file as a the disc image
and boot the virtual machine. Use the information below when going through the
installation steps.
Boot##
#
#
CD Found#
#
Welcome##
#
Install language#
Keyboard##
#
Warning pop-up#
Partitioning# #
Warning pop-up#
Network devices#
#
#
#
#
#
#
#
#
Hostname#
#
Misc. Settings##
#
#
#
#
Region# #
#
Root password#
Optional Software#

Press <ENTER> to install in graphical mode
Skip the media test
Next
English (English)
U.S. English
Yes
Remove linux partitions on selected drives and create default layout
Yes
IP4 Manual Configuration, Automatically obtain IP address settings
with dhcp. Automatically obtain DNS information from provider.
Disable the IPv6 support
soasuite11g
Set your Gateway and DNS if required. When leaving the fields blank
select "Continue" in the "Error With Data" pop-up's.
Select your region
Welcome1
Select "Software Development"

Reboot your VM and then configure OEL using the information below.
Firewall# #
SELinux# #

#
#

Disabled
Disabled

Reboot once again and logon as root. Now install VMware Tools by selecting "Virtual
Machine"->"Install VMware tools" from the VMware menu-toolbar.
If it is the first time you install VMware tools on a linux VM, the tools will be downloaded.
Select "Install" in the pop-up menu. Open a Terminal session(Applications->Accesories>Terminal) and extract the VMware Tools tar file to /tmp
tar -xzf /media/VMware\ Tools/VMwareTools-8.4.5-332101.tar.gz -C /
tmp
Start the VMware tools installation by entering the instructions below in the terminal. You
can accept all default settings during the installation process. To enable advance X
features follow the instructions shown in the last lines of the output of the VMware Tools
installer.
cd /tmp/vmware-tools-distrib
./vmware-install.pl
Open the file /etc/hosts with vi. If you are not familiar with vi, take a look here. Verify if the
content of the file matches the example below and make if necessary changes to the file.
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# Do not remove the following line, or various programs
# that require network functionality will fail.
127.0.0.1
localhost localhost.localdomain
172.16.243.132
soasuite11g soasuite11g.localdomain

Disable unnecessary processes by executing the following instructions in Terminal.
chkconfig
chkconfig
chkconfig
chkconfig
chkconfig
chkconfig
chkconfig
chkconfig
chkconfig
chkconfig
chkconfig

--levels
--levels
--levels
--levels
--levels
--levels
--levels
--levels
--levels
--levels
--levels

345
345
345
345
345
345
345
345
345
345
345

sendmail off
bluetooth off
cups off
hplip off
smartd off
isdn off
nfslock off
readahead_early off
readahead_later off
setroubleshoot off
pcscd off

Finally reboot your VM to finalize the installation process.

Oracle Database 11gR2 installation
Configure the VMs CD/DVD device to use the Oracle Linux ISO file once as the disc
image and make sure it is connected. Logon as root to OEL and start a Terminal session.
Install additional required Linux packages by executing the instructions below.
cd /media/Oracle\ Linux\ Server\ dvd\ 20110119/Server/
rpm -Uvh sysstat-* unixODBC-2* unixODBC-devel-2* libaio-devel-*
Create the necessary user, group and directory-structure by executing the instructions
below in the Terminal session.
/usr/sbin/groupadd oracle
/usr/sbin/useradd -m -g oracle oracle
echo Welcome1 | passwd --stdin oracle
mkdir -p /data/app/oracle
chown -R oracle:oracle /data/app
chmod -R 775 /data/app
Now test if the account oracle with password Welcome1 has been successfully created by
logging of (System->Log Out root...) and logging on using the username oracle.
Now you can start the installation of Oracle DB 11gR2. Log on as oracle and start a
Terminal session.
cd /mnt/hgfs/Soa_Suite_Components/V17530-01/database
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./runInstaller
Use the information in the table below to guide you through the installation process.
Option

Action

Configure Security
Updates

Leave the fields Email and My Oracle support password
empty and deselect I wish to receive security updates via My
Oracle Support

Installation Option

Create and configure a database

System Class

Desktop Class

Typical Installation

Oracle base:
#
/data/app/oracle
Software Location:
#
/data/app/oracle/product/11.2.0/dbhome_1
Database file loc.:
#
/data/app/oracle/oradata
Edition:
#
Standard Edition One
Character set:
#
Unicode (AL32UTF8)
OSDBA Group:
#
dba
Global Database Name:
#
orcl
Admin password:
#
Welcome1

Create Inventory

Inventory Directory:
#
/data/app/oraInventory
orainventory Group Name:
#
dba

Prerequisite Checks

Select Fix & Check Again
Open a new terminal session an execute the fixup scripts as
root by executing the instruction below. After starting the
script a password is requested. Type here the password of
root (Welcome1).
su -c /tmp/CVU_11.2.0.1.0_oracle/runfixup.sh
After the script has been executed, select OK in the pop-up
window Execute Fixup Scripts.

Summary
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The Database Configuration Assistant will finally show a summary of the database creation
process. If necessary take notes, and select OK to finalize the database creation process.
To complete the installation process, execute the scripts shown in the Execute
Configuration scripts pop-up window. Open a new terminal session an execute the scripts
as root by executing the instructions one by one below. After starting each script the rootpassword is requested, type here the password of root (Welcome1). Accept all defaults for
the requested paths by pressing enter.
su -c /data/app/oraInventory/orainstRoot.sh
su -c /data/app/oracle/product/11.2.0/dbhome_1/root.sh
Select OK in the Execute Configuration scripts pop-up window and select Finish in the
Installer window. Note the EM Database Control URL:
https://soasuite11g:1158/em

Oracle environment and Auto Startup and Shutdown
If you would restart the system after the installation of the database, you have to start the
Database, Listener and Enterprise Manager manually. Take the next few steps to
automatically start these processes when booting the OS.
Logon as root to OEL and start a Terminal session.
Make changes to the .bashrc file of user oracle by running the script below in the terminal
session.
su - oracle
cat >> /home/oracle/.bashrc << EOF
ORACLE_HOSTNAME=soasuite11g
ORACLE_BASE=/data/app/oracle/product/11.2.0
ORACLE_HOME=${ORACLE_BASE}/dbhome_1
ORACLE_UNQNAME=orcl
ORACLE_SID=orcl
LD_LIBRARY_PATH=$ORACLE_HOME/lib
PATH=$PATH:$ORACLE_HOME/bin
export ORACLE_BASE ORACLE_HOME ORACLE_SID ORACLE_UNQNAME
LD_LIBRARY_PATH PATH
export ORACLE_HOSTNAME
EOF
exit
Open the file /etc/oratab with vi. Change the last line of the line for SID orcl from N to
Y. The line will look like similar to orcl:/data/app/oracle/product/11.2.0/
dbhome_1:Y , save the file and leave the editor.
Create the file oracle in directory /etc/init.d by copying the content below to the
terminal session.
cat >> /etc/init.d/oracle << EOF
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#!/bin/bash
#
# oracle Init file for starting and stopping
# Oracle Database. Script is valid for 10g and 11g versions.
#
# chkconfig: 35 80 30
# description: Oracle Database startup script
# Source function library.
. /etc/rc.d/init.d/functions
ORACLE_OWNER="oracle"
ORACLE_HOME="/data/app/oracle/product/11.2.0/dbhome_1"
case "\$1" in
start)
echo -n \$"Starting Oracle DB:"
su - \$ORACLE_OWNER -c "\$ORACLE_HOME/bin/dbstart \$ORACLE_HOME"
echo "OK"
;;
stop)
echo -n $"Stopping Oracle DB:"
su - \$ORACLE_OWNER -c "\$ORACLE_HOME/bin/dbshut \$ORACLE_HOME"
echo "OK"
;;
*)
echo \$"Usage: \$0 {start|stop}"
esac
EOF
Execute the following instructions to change the permissions and setting runlevel
execution of the newly created oracle script.
chmod 750 /etc/init.d/oracle
chkconfig --add oracle --level 0356
Create the file oraemctl in directory /etc/init.d by copying the content below to the
terminal session.
cat >> /etc/init.d/oraemctl << EOF
#!/bin/bash
#
# oraemctl Starting and stopping Oracle Enterprise Manager
# Database Control.
# Script is valid for 10g and 11g versions.
#
# chkconfig: 35 80 30
# description: Enterprise Manager DB Control startup script
# Source function library.
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. /etc/rc.d/init.d/functions
ORACLE_OWNER="oracle"
ORACLE_HOME="/data/app/oracle/product/11.2.0/dbhome_1"
ORACLE_UNQNAME=”orcl”
case "\$1" in
start)
echo -n \$"Starting Oracle EM DB Console:"
su - \$ORACLE_OWNER -c "\$ORACLE_HOME/bin/emctl start dbconsole"
echo "OK"
;;
stop)
echo -n \$"Stopping Oracle EM DB Console:"
su - \$ORACLE_OWNER -c "\$ORACLE_HOME/bin/emctl stop dbconsole"
echo "OK"
;;
*)
echo \$"Usage: \$0 {start|stop}"
esac
EOF
Execute the following instructions to change the permissions and setting runlevel
execution of the newly created oracle script.
chmod 750 /etc/init.d/oraemctl
chkconfig --add oraemctl --level 0356
Verify the changes by stopping Oracle Enterprise Manager and Database instance using
the scripts. Execute the following two instructions in the terminal window, each instruction
should report OK as a result.
/etc/init.d/oracle stop
/etc/init.d/oraemctl stop

Page 11 of 29
Dutch tilt

How to: SOA Suite 11g R1 on Oracle Linux in VM Ware Fusion

Reboot the system and log on as oracle. Test the
automatic startup of the Oracle DB and EM by
opening the url https://soasuite11g:1158/em in
Firefox. Log on as user SYS with password
Welcome1 as SYSDBA. The page shows the
status for database instance orcl, verify that the
status is up.

Oracle DB Memory Optimization
It is not necessary to start Oracle Enterprise Manager on boot. Instead of this OEM can be
started manually when needed. OEM allocates approximately 800M in memory, which is a
considerable amount in a memory constrained system. You can prevent starting OEM on
boot by changing the runlevel of the oraemctl script. To change the runlevel, logon as root
to OEL and start a Terminal session. Then execute the following statements.
su - root
chkconfig --level 356 oraemctl off
exit
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If necessary OEM can be started manually by using the following instructions in Terminal
when logged on as oracle or soaadmin
su - root
/etc/init.d/oraemctl start
The memory target for Oracle DB 11gR2 after an Standard Edition One installation is
800M. This target can be set to the minimum values by logging on as oracle to OEL and
starting a Terminal session, then execute the following script.
cd /data/app/oracle/product/11.2.0/dbhome_1/bin
./sqlplus / as SYSDBA << EOF
alter system set memory_max_target=152M scope=spfile;
alter system set memory_target=152M scope=spfile;
startup force;
EOF
The script should finish with an output similar to;
Total System Global Area
Fixed Size
Variable Size
Database Buffers
Redo Buffers
Database mounted.
Database opened.

158662656
2211448
121635208
29360128
5455872

bytes
bytes
bytes
bytes
bytes

Repository Creation
Make sure you are logged on as user oracle. Open a new terminal session an execute the
instructions below to start the Repository Creation Utility.
cd /mnt/hgfs/Soa_Suite_Components/V24311-01/bin
./rcu
Use the information in the table below to guide you through the repository creation
process.
Option

Action

Welcome

Select Next

Create Repository

Select Create
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Option

Action

Database Connection
Details

Database Type#
Host Name# #
Port# #
#
Service Name#
Username# #
Password# #
Role# #
#

: Oracle Database
: localhost
: 1521
: orlc
: sys
: Welcome1
: SYSDBA

In the “Checking Prerequisites” pop-up window an overview
is shown of the prerequisite test results. Validate that all
prerequisites have been met, then press OK
Select Components

Select at least SOA and BPM Infrastructure, this will
automatically select Metadata Services under AS Common
Schemas.
In the “Checking Prerequisites” pop-up window an overview
is shown of the prerequisite test results. Validate that all
prerequisites have been met, then press OK

Schema Passwords

Select Use same passwords for all schemas and use
Welcome1 as a password.

Map Tablespaces

Select Next
Confirm the tablespace creation by selecting OK in the
Repository Creation Utility pop-up window.

Summary

Select Create

Completion Summary

Verify that the status of each component is equal to success
and select close.
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WebLogic installation
Logon as root to OEL and start a Terminal session.
Oracle Weblogic Server and SOA Suite require at least Sun JDK 1.6.0_21+. Verify the
current default Java version by entering the instruction java --version in the Terminal
session. If the current version does not meet the minimum requirements, upgrade java to
the minimum level bu executing the following instructions.
Execute the instructions below in a Terminal-session, this will start the installation of the
JDK. Follow the instructions on screen.
cd /tmp
cp /mnt/hgfs/Soa_Suite_Components/JDK/* /tmp
chmod u+x jdk-6u23-linux-x64-rpm.bin
./jdk-6u23-linux-x64-rpm.bin
Test is the JDK has been successfully installed by entering the instruction /usr/java/
latest/bin/java -version in the terminal, it should report java version "1.6.0_23" or
similar build higher than 21. Now make this installed java version the default version by
executing the following instructions in the terminal.
cd /usr/java
mv default old
ln -s /usr/java/jdk1.6.0_23 default
update-alternatives --install "/usr/bin/java" "java" \
"/usr/java/jdk1.6.0_23/bin/java" 1
update-alternatives --set java \
/usr/java/jdk1.6.0_23/bin/java
Check if the installed JDK is the default java by executing java -version in the
terminal.
Create the necessary user, group and directory-structure to install Weblogic and SOA
Suite with a dedicated (not a root) user by executing the instructions below in the Terminal
session.
/usr/sbin/useradd -m -g oracle soaadmin
echo Welcome1 | passwd --stdin soaadmin
mkdir -p /data/middleware
chown -R soaadmin:oracle /data/middleware
chmod -R 775 /data/middleware
Now test if the account soaadm with password Welcome1 has been successfully created
by logging of (System->Log Out root...) and logging on using the username soaadmin.
Start the Weblogic installer by executing the instructions below in the terminal.
cd /mnt/hgfs/Soa_Suite_Components/V24338-01
java -d64 -jar wls1034_generic.jar
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Use the information in the table below to guide you through the installation process.
Option

Action

Welcome

Next

Choose Middleware
Home Directory

Middleware Home Type:
#
Create a new Middleware Home
Middleware Home Directory:
#
/data/middleware

Register for Security
Updates

Email: <leave empty>
I wish to receive security updates via My Oracle Support:
#
de-select
Support Password: <leave empty>

Choose Install Type

Typical

JDK Selection

By default the previously installed JDK should be selected.
Make sure Sun SDK 1.6.0 with at least build 21 is selected
in the Local JDK pane.

Choose Product
Installation Directories

Weblogic Server: /data/middleware/wlserver_10.3
Oracle Coherence: /data/middleware/coherence_3.6

Installation Summary

Next

Installation Complete

Run Quickstart: de-select

Install SOA Suite
SOA Suite requires that the kernel parameters for the soft and hard limit of open files are
set to a minimum of 4096. Logon as root to OEL and start a terminal session. Run the
script below in the terminal and shutdown and reboot the system.
cat >> /etc/security/limits.conf << EOF
soaadmin soft nofile 4096
soaadmin hard nofile 4096
Page 16 of 29
Dutch tilt

How to: SOA Suite 11g R1 on Oracle Linux in VM Ware Fusion

EOF
Logon as soaadmin to OEL and start a terminal session. Start the SOA Suite Installer by
entering the following instructions on the terminal.
cd /mnt/hgfs/Soa_Suite_Components/V24313-01/Disk1
./runInstaller -jreLoc /usr/java/default/jre
Use the information in the table below to guide you through the installation process.
Option

Action

Welcome

Next

Install Software
Updates

Skip Software Updates

Prerequisite Checks

All checks should be passed

Specify Installation
Location

Oracle Middleware Home: /data/middleware
Oracle Home Directory: Oracle_SOA1

Application Server

Weblogic Server

Installation Summary

Select Install

Installation Process

Select Next

Installation Complete

Select Finish

Configure SOA Suite
The SOA Suite software must be configured in WebLogic by creating a new Domain and
configuring the SOA Suite software.
Logon as soaadmin to OEL and start a terminal session. Start the Fusion Middleware
Configuration Wizard by entering the following instructions on the terminal.
cd /data/middleware/Oracle_SOA1/common/bin
./config.sh
Use the information in the table below to guide you through the installation process.
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Option

Action

Welcome

Create a new Weblogic domain

Select Domain Source

Generate a domain configured automatically to support the
following products:
* Basic Weblogic Server Domain
* Oracle BPM Suite
* Oracle SOA Suite
* Oracle Enterprise Manager
* Oracle Business Activity Monitoring
* Oracle WSM Policy Manager
* Oracle JRF

Specify Domain Name
and Location

Domain name:
#
soa_domain
Domain location:
#
/data/middleware/user_projects/domains
Application location:
#
/data/middleware/user_projects/applications

Configure
Administrator User
Name and Password

Name: weblogic
User password: Welcome1
Confirm user password: Welcome1
Description: This user is the default administrator.

Configure Server Start
Mode and JDK

Weblogic Domain Startup Mode: Development Mode
Available JDKs: By default the previously installed JDK
should be selected. Make sure Sun SDK 1.6.0 with at least
build 21 is selected in the Local JDK pane.

Configure JDBC
Component Schema

Select the following Component Schemas
* BAM Schema
* SOA Infrastructure
* User Messaging Service
* OWSM MDS Schema
* SOA MDS Schema
Host Name: localhost
Schema Password: Welcome1

Test JDBC
Component Schema

All connections should be tested successfully.

Select Optional
Configuration

Do not select any additional configurations and select Next.

Configuration
Summary

Select Create
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Option

Action

Creating Domain

Select Done

JDeveloper installation
Logon as soaadmin to OEL and start a terminal session. Start the Fusion Middleware
Configuration Wizard by entering the following instructions on the terminal.
cd /mnt/hgfs/Soa_Suite_Components/V24372-01
java -jar ./jdevstudio11114install.jar
Use the information in the table below to guide you through the installation process.

Option

Action

Welcome

Next

Choose Middleware
Home Directory

Middleware Home Type: Use an Existing Middleware Home
Middleware Home Directory: /data/middleware

Choose Products and
Components

Use default selection

JDK Selection

Verify that a local JDK with at least version 1.6.0 build 21 is
selected.

Confirm Product
Installation Directories

Select Next

Installation Summary

Select Next

Installation Complete

De-select Run Quickstart

Create a shortcut to JDeveloper by Control-Click on the Desktop and selecting Create
Launcher... from the pop-up menu. Use the information in the table below to fill in the
properties.
Option

Property

Icon

/data/middleware/jdeveloper/jdev/bin/coffee.png

Type

Application

Name

JDeveloper 1.1.1.4.x

Command

/data/middleware/jdeveloper/jdev/bin/jdev
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Start JDeveloper and select Default Role, de-select always prompt for role selection on
startup. De-select Allow automated usage reporting to Oracle in window Oracle Usage
Tracking window.
Start the JDeveloper update wizard by selecting Help->Check for Updates... in the menubar. Use the information in the table below to guide you through the wizard.
Option

Action

Welcome

Next

Source

Install From Local File:
#
/mnt/hgfs/Soa_Suite_Components/V24372-01/
middleware_extensions/soa-jdev-extension.zip
Restart JDeveloper

Source

Install From Local File:
#
/mnt/hgfs/Soa_Suite_Components/V24372-01/
middleware_extensions/bpm-jdev-extension.zip
Restart JDeveloper

Installation OSB
Logon as soaadmin to OEL and start a terminal session. Start the OSB Installer by
entering the following instructions on the terminal.
cd /mnt/hgfs/Soa_Suite_Components/V24316-01/Disk1/runInstaller
./runInstaller -jreLoc /usr/java/default/jre
Use the information in the table below to guide you through the installation process.
Option

Action

Welcome

Next

Install Software
Updates

Skip Software Updates

Installation Location

Oracle Middleware Home: /data/middleware
Oracle Home Directory: Oracle_OSB1

Installation Type

Typical

Prerequisite Checks

All checks should be have a status passed
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Option

Action

Product Home
Location

Weblogic Server Location:
#
/data/middleware/wlserver_10.3
OEPE Location: <Leave empty>

Installation Summary

Select Install

Installation Progress

Next

Installation Completed

Finish

Now extend the WLS domain with OSB by executing the OSB Configuration Wizard
cd /data/middleware/Oracle_OSB1/common/bin
./config.sh
Use the information in the table below to guide you through the installation process.
Option

Action

Welcome

Extend an existing WebLogic domain

Select a Weblogic
Domain Directory

Select the Domain Directory:
#
/data/middleware/user_projects/domains/soa_domain

Select Extension
Source

Extend my domain automatically to support the following
added products:
* Oracle Services Bus
* Weblogic Advanced Web Services for JAX-RPC Extension
* Oracle Service Bus OWSM Extension

Configure JDBC
Component Schema

Select the following Component Schemas
* OSB JMS Reporting Provider
Vendor: Oracle
Driver: *Oracle;ʼs Driver (Thin) for Instance connections
Schema Owner: DEV_SOAINFRA
Schema Password: Welcome1
Host Name: localhost
DBMS/Service: ORCL
Port: 1521

Test JDBC
Component Schema
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Option

Action

Welcome

Extend an existing WebLogic domain

Select a Weblogic
Domain Directory

Select the Domain Directory:
#
/data/middleware/user_projects/domains/soa_domain

Select Extension
Source

Extend my domain automatically to support the following
added products:
* Oracle Services Bus
* Weblogic Advanced Web Services for JAX-RPC Extension
* Oracle Service Bus OWSM Extension

Configure JDBC
Component Schema

Select the following Component Schemas
* OSB JMS Reporting Provider
Vendor: Oracle
Driver: *Oracle;ʼs Driver (Thin) for Instance connections
Schema Owner: DEV_SOAINFRA
Schema Password: Welcome1
Host Name: localhost
DBMS/Service: ORCL
Port: 1521

Test JDBC
Component Schema
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launchers (shortcuts) to the scripts. Follow the next steps to create the necessary
launchers for the Admin server and Managed (soa_server1, bam_server1).
Logon as soaadmin to OEL and start a terminal session. Create a shortcut to AdminServer
by Control-Click on the Desktop and selecting Create Launcher... from the pop-up menu.
Use the information in the table below to fill in the properties.
Option

Property

Icon
Type

Application in Terminal
Optionally you can change it to Application, preventing an
open terminal on your desktop while running the
AdminServer

Name

Start AdminServer

Command

/data/middleware/user_projects/domains/soa_domain/
startWebLogic.sh

Create a shortcut to start the soa_server1 by Control-Click on the Desktop and selecting
Create Launcher... from the pop-up menu. Use the information in the table below to fill in
the properties.
Option

Property

Icon
Type

Application in Terminal
Optionally you can change it to Application, preventing an
open terminal on your desktop while running the
AdminServer

Name

Start soa_server1

Command

/data/middleware/user_projects/domains/soa_domain/bin/
startManagedWebLogic.sh soa_server1

Create a shortcut to start the bam_server1 by Control-Click on the Desktop and selecting
Create Launcher... from the pop-up menu. Use the information in the table below to fill in
the properties.
Option

Property

Icon
Type
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Option

Property

Name

Start bam_server1

Command

/data/middleware/user_projects/domains/soa_domain/bin/
startManagedWebLogic.sh bam_server1

Create a shortcut to start the osb_server1 by Control-Click on the Desktop and selecting
Create Launcher... from the pop-up menu. Use the information in the table below to fill in
the properties.
Option

Property

Icon
Type

Application in Terminal

Name

Start osb_server1

Command

/data/middleware/user_projects/domains/soa_domain/bin/
startManagedWebLogic.sh osb_server1

Now start the AdminServer using the launcher and wait till the startup process is
completed. The AdminServer startup process is completed when the message Server
started in RUNNING mode is written to the terminal.
Continue starting the Managed Servers soa_server1, osb_server1 and bam_server1 one
at a time using the launcher. The servers startup process is completed when the message
Server started in RUNNING mode is written to the terminal. Stop the server by
pressing Control_C in the terminal session, then start the next managed server. During the
startup a username and password is requested to boot the Weblogic server. Use the
username weblogic and password Weblogic1 (admin credentials of the weblogic domain)
here to log on. During the startup the directory structure for the servers is created under /
data/middleware/user_projects/domains/soa_domain/servers.
To prevent the login-prompt shown during server startup of the Managed Server, the
credentials necessary to boot the Weblogic server can be added to the boot.properties file.
Do not continue if you not have started the servers once because the boot.properties file
has to be created in the directory structure which is generated during the first startup of the
Managed Server.
To create the boot.properties for the soa_server1, osb_server1 and bam_server1, logon as
soaadmin to OEL and start a terminal session. Execute the following scripts in the
Terminal.
mkdir /data/middleware/user_projects/domains/soa_domain/servers/
soa_server1/security
cat >> /data/middleware/user_projects/domains/soa_domain/servers/
soa_server1/security/boot.properties << EOF
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username=weblogic
password=Welcome1
EOF
mkdir /data/middleware/user_projects/domains/soa_domain/servers/
bam_server1/security
cat >> /data/middleware/user_projects/domains/soa_domain/servers/
bam_server1/security/boot.properties << EOF
username=weblogic
password=Welcome1
EOF
mkdir /data/middleware/user_projects/domains/soa_domain/servers/
osb_server1/security
cat >> /data/middleware/user_projects/domains/soa_domain/servers/
osb_server1/security/boot.properties << EOF
username=weblogic
password=Welcome1
EOF
All Weblogic servers; AdminServer, soa_server1, osb_server1 and bam_server1 do run in
the same domain. Therefore these servers share the same environment settings which are
set on startup. A part of these environment settings are the JVM memory settings. To set
the JVM memory settings for each server individually, add the code below to the
setSOADomainEnv.sh. Verify that you are logged on as soaadmin and open the file
setSOADomainEnv.sh in directory /data/middleware/user_projects/domains/
soa_domain/bin. Add the code below between the last comment statement and the if
[ "${XENGINE_DIR}" = "" ]; then statement.
echo "Server Name:${SERVER_NAME}"
echo -ne "\033]0;"${SERVER_NAME}"\007"
if [ "${SERVER_NAME}" = "soa_server1" ]; then
echo "Setting USER_MEM_ARGS for soa_Server1"
echo "| HEAP 640M
| PermGen 390-512M |"
echo "| SHORT (YOUNG) 224M
: LONG 416M
|
|"
echo "| eden : s0
: s1
:
|
|"
echo "| 168
: 28M : 28M
:
|
|"
USER_MEM_ARGS="-Xms640m -Xmx640m -Xmn224m -XX:SurvivorRatio=8 \
-XX:PermSize=390m -XX:MaxPermSize=512m -XX:+UseSerialGC -d64"
elif [ "${SERVER_NAME}" = "osb_server1" ]; then
echo "Setting USER_MEM_ARGS for bam_Server1"
echo "| HEAP 224M
| PermGen 224M
|"
echo "| SHORT (YOUNG) 32M
: LONG 192M
|
|"
echo "| eden : s0
: s1
:
|
|"
echo "| 24M
: 4M
: 4M
:
|
|"
USER_MEM_ARGS="-Xms224m -Xmx224m -Xmn32m -XX:SurvivorRatio=8 \
-XX:PermSize=224m -XX:MaxPermSize=224m -XX:+UseSerialGC -d64"
elif [ "${SERVER_NAME}" = "bam_server1" ]; then
echo "Setting USER_MEM_ARGS for bam_Server1"
echo "| HEAP 224M
| PermGen 250M
|"
echo "| SHORT (YOUNG) 64M
: LONG 160M
|
|"
echo "| eden : s0
: s1
:
|
|"
echo "| 48M
: 8M
: 8M
:
|
|"
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USER_MEM_ARGS="-Xms224m -Xmx224m -Xmn64m -XX:SurvivorRatio=8 \
-XX:PermSize=250m -XX:MaxPermSize=250m -XX:+UseSerialGC -d64"
elif [ "${SERVER_NAME}" = "AdminServer" ]; then
echo "Setting USER_MEM_ARGS for AdminServer"
echo "| HEAP 384M
| PermGen 320-512M |"
echo "| SHORT (YOUNG) 64M
: LONG 288M
|
|"
echo "| eden : s0
: s1
:
|
|"
echo "| 64M
: 2M
: 2M
:
|
|"
USER_MEM_ARGS="-Xms384m -Xmx384m -Xmn64m -XX:SurvivorRatio=32 \
-XX:PermSize=320m -XX:MaxPermSize=512m -XX:+UseSerialGC -d64"
else
echo "USER_MEM_ARGS not set"
fi

The JDK can be optimized further by invoking the Java HotSpot Server instead of the
HotSpot client to compile bytecode into machine optimized instructions. When invoking the
HotSpot server initialization of the application will be slightly slower but due to further
optimization of the bytecode but it will run faster. To enable the HotSpot server in Weblogic
servers, the environment variable PRODUCTION_MODE must be set to true.
Verify that you are logged on as soaadmin and open the file commEnv.sh in directory /
data/middleware/wlserver_10.3/common/bin. Add the code below after the
statement JAVA_USE_64BIT=true which will be approximately at line 143.
# Optimize Compiler
PRODUCTION_MODE="true"

JDeveloper on Mac OS X
When using JDeveloper and a web browser on the host OS, you will experience a better
performance than when running the client applications within the VM. Follow the
instructions below to install JDeveloper on Mac OS X.
First verify that java SE 6 64 bit is the prefered JVM. Open the utilities folder by selecting
⌘⇧U in Finder and open Java Preferences. Select the tab General in Java Preferences
and move the 64-bit Java SE 6 to the top of the list. Close the Java Preferences by
selecting ⌘Q.
By default JDeveloper installer is not able to locate the JDK. Open Terminal in OS X by
selecting ⌘⇧U in finder and starting Terminal. Execute the following instructions in
Terminal. When a password is requested, type your OS X login account.
cd /System/Library/Frameworks/JavaVM.framework/Versions/1.6.0/Home
sudo mkdir jre
cd jre
sudo mkdir lib
cd lib
sudo ln -s /System/Library/Frameworks/JavaVM.framework/\
/Versions/1.6.0/classes/classes.jar rt.jar
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Start the JDeveloper installer by opening the jdevstudio11114install.jar which is in the
Soa_Suite_Components/V24372-01 folder. Use the information in the table below to guide
you through the installation process.

Option

Action

Welcome

Next

Choose Middleware
Home Directory

Middleware Home Type: Use an Existing Middleware Home
Middleware Home Directory: Use default

Choose Products and
Components

Use default selection

JDK Selection

Use default selection, verify that at least Apple JDK version
1.6 is selected.

Confirm Product
Installation Directories

Select Next

Installation Summary

Select Next

Installation Complete

De-select Run Quickstart

JDeveloper will now be installed in subdirectory Oracle/middleware of your home directory.
Drag the JDeveloper java application to your dock by dragging the JDeveloper to the dock.
You can select ⇧⌘G in Finder to go to a folder. Then enter ~/Oracle/Middleware as
the folder name. The JDeveloper application is in the opened folder.
Start the JDeveloper application and update wizard in JDeveloper by selecting Help>Check for Updates... in the menu-bar. Use the information in the table below to guide you
through the wizard.
Option

Action

Welcome

Next

Source

Install From Local File:
#
Soa_Suite_Components/V24372-01/
middleware_extensions/soa-jdev-extension.zip
Restart JDeveloper
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Option

Action

Source

Install From Local File:
#
Soa_Suite_Components/V24372-01/
middleware_extensions/bpm-jdev-extension.zip
Restart JDeveloper

Finishing up
When connecting from a browser outside you SOA Suite server, e.g. using Safari on your
host OS, you need the ip-address of the server. You can retrieve the ip-address by
opening a Terminal session on the server and entering the following instruction. The
required password is Welcome1.
su - root -c " ifconfig eth0 | grep 'inet addr:' "
To access the SOA components by the hostname of the guest OS from your host OS, add
the name of guest Operating System to the hosts file of your host OS. Open Terminal in
OS X by selecting ⌘⇧U in finder and starting Terminal. Execute the following instructions
in Terminal. When a password is requested, type your OS X login account. (Replace the
shown ip-address by the address of the guest os)
sudo -s 'echo "172.16.243.132"

soasuite11g >> /etc/hosts'

The console URL for the applications installed are shown here. When accessing the
applications using a browser outside the server, replace the localhost with the ipaddress of the SOA Server.
Welcome to Fusion Middleware#
Weblogic Server Admin console#
EM Fusion Middleware Control #
SOA Composer#
#
#
BPM Worklist#
#
#
BPM Composer#
#
#
B2B console##
#
#
BAM # #
#
#
#
OSB Admin Console#
#

: http://localhost:7001
: http://localhost:7001/console
: http://localhost:7001/em
: http://localhost:8001/soa/composer
: http://localhost:8001/integration/worklistapp
: http://localhost:8001/bpm/composer
: http://localhost:8001/b2b
: http://localhost:9001/OracleBAM
: http://localhost:7001/sbconsole

Oracle BAM requires internet explorer 7 or 8. I have made an attempt to access the
application using Firefox 3.6.13 but it stalls on a missing plug-in. Which plug-in is missing
is not reported. On Safari i am able to get the initial logon page when changing the default
login agent to Internet Explorer 7 or 8. When making an attempt to logon, nothing happens
after entering the credentials and selecting the go button.
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Change history
Version

Changes / remarks

0.1

Initial draft

0.2

Initial public release

0.3

Added some application URLs
Script setSOADomainEnv.sh modified
Added soasuite11g as host in /etc/hosts
References to localhost replaced by soasuite11g

Referenced documentation
Installation of Oracle 11g Release 2 (11.2.0.1.0) on RedHat EL 5,
(Oracle) Enteprise Linux 5 and Centos 5
How to Install Java JRE 1.6.0 (Update x) in Linux as the Default Java Runtime, including
Firefox Browser Plugin
What are the Linux x64 RPM Java installation instructions ?
Installing JDeveloper 11g on Mac OS 10.5
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